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CHAPTER 3 CHART OBJECT FORMATTING 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

While charts are created with a default appearance, you can 
change the formatting of each object that comprises the chart to 
create a fully customised version. 

In this session you will: 

 gain an understanding of chart objects and how they can 
be formatted 

 learn how to select chart elements 

 learn how to use shape styles to format objects 

 learn how to change column colour 

 learn how to change the colour of a pie slice 

 learn how to change bar colours 

 learn how to change chart line colours 

 learn how to use shape effects 

 learn how to fill the chart area and the plot area 

 learn how to fill the background 

 gain an understanding of the Format dialog box 

 learn how to use the Format dialog box 

 learn how to apply a theme to a chart. 

INFOCUS 

WPL_E833 
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UNDERSTANDING CHART OBJECT FORMATTING 
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Charts are complex drawings that are made up of 
a wide range of text and graphical elements. 
Each object can be formatted individually to 
create fully customised charts. The objects in a 

chart vary a little depending on the chart type, but 
in general the objects are fairly standard. This page 
examines a range of chart objects and the 
formatting that can be used to modify them. 

Chart Objects 

Chart objects include lines, shapes and the background of the slide. The following examples apply to 
the column chart shown above. 

 The chart background is the area behind the chart and it is usually hidden. You can 
insert a picture in the background to make the chart more visually appealing. 

 The chart area is the overall area occupied by the chart. 

 The plot area is the area in which the figures are plotted. 

 Series are the groups of figures plotted on the chart. In this example there are three 
series: Jan, Feb and Mar. 

 The vertical and horizontal axes mark the edges of the chart and display the categories 
and scale. 

Object Formatting Options 

 Shape Fill settings, such as solid colour, gradient, picture and texture, change the inside of a 
shape. 

 Shape Outline settings control the colour, weight and pattern of lines or the outlines of shapes. 

 Shape Effects modify the entire shape by adding different surface textures, shadows, glow effects, 
soft edges, bevel effects or 3-D effects. Examples of different effects are shown on the series, plot 
area and chart area above. 

 Shape Styles modify shapes with various combinations of shape fill, outline and effect. 
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SELECTING CHART ELEMENTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

O
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 Before starting this exercise you 

MUST open the file E833 Chart 
Formatting_1.xlsx... 

 Click on the chart to display the 
Chart Tools tab, then click on 
the Format tab 

 Click on the Title to select it 

 Pale blue handles will appear 
around the title showing that it is 
selected. Now you can format or 
move the title ... 

 Click on a number in the vertical 
axis to select it 

 You can also select elements 
from a list... 

 Look at the Chart Elements 
control in the Current Selection 
group 

 This indicates that the Vertical 
(Value) Axis is selected... 

 Click on the drop arrow  for 
Chart Elements to display the 
list 

 Select Series “Dublin” to select 
the red line in the chart 

 Pale blue handles will appear 
around each data point... 

 Click outside the chart to 
deselect the series 

 

For Your Reference… 

To select chart elements: 

1. Click on the element 

OR 

1. Click on the drop arrow  for Chart 

Elements and click on the element name 

Handy to Know… 

 The only part of the chart that can’t be 
selected using Chart Elements is the 
background. 

2 
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Before you can apply formatting to an element in 
a chart, you need to be able to select it 
accurately so that you don’t accidentally format 
the wrong thing. Once you’re comfortable 

working with charts, you’ll learn where to click to 
select specific objects, but if you’re not sure, Excel 
provides a special control which helps you do just 
that. It’s called Chart Elements. 
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USING SHAPE STYLES TO FORMAT OBJECTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file E833 Chart 
Formatting_2.xlsx... 

 Click on the Costs By Month 
chart sheet tab 

 This is a basic column chart... 

 Click on the first blue column 
for Auckland, to select it 

 The entire Jan series will be 
selected... 

 Click on the Chart Tools: 
Format tab in the Ribbon, 
then click on the More button 

 for Shape Styles to see the 
options 

 The tool tip displays the name 
of each style as you point to 
it... 

 Click on Intense Effect – 
Accent 1 (2

nd
 column, bottom 

row) to apply it 

 The series is reformatted... 

 Repeat steps 2 to 4 to apply 
the corresponding Intense 
effects to the Feb (red) and 
Mar (green) series 

 

For Your Reference… 

To use a shape style to format a chart object: 

1. Select the chart object 

2. Click on the More button  for Shape 

Styles and select the style 

Handy to Know… 

 You can remove a Shape Style by clicking 
on the object and clicking on Reset to Match 

Style  in the Current Selection group of 
the Chart Tools: Format tab. 

2 

5 

Shape Styles take the guesswork out of 
formatting chart objects by allowing you to apply 
a shape fill, outline and effects in one step. They 
are especially effective for series objects such as 

columns, lines, bars and pie slices. There’s a range 
of styles to choose from plus a selection of 
complementary colours. 
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CHANGING COLUMN COLOUR 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file E833 Chart 
Formatting_3.xlsx... 

 If the green series for Mar isn’t 
already selected, click on the 
green column for Auckland 

 Click on the Chart Tools: 
Format tab then click on the 

drop arrow for Shape Fill  
to display the options 

 There is a selection of colours 
based on the theme as well as 
standard colours and effects... 

 Click on Orange, Accent 6 (1
st
 

row, far right column) to apply 
the colour to the series 

 This is one way to change 
colour... 

 Click on the drop arrow for 

Shape Fill  then select 
More Fill Colours to display 
the Colours dialog box 

 You can specify any colour 
you like... 

 Click on the Standard tab then 
click on green in the middle 
row (3

rd
 from left) 

 Click on [OK] to apply the  
intense green colour 

 

For Your Reference… 

To change column colour: 

1. Click on the column in the series to select it 

2. Click on the drop arrow for Shape Fill  

3. Click on the colour of your choice 

Handy to Know… 

 You can also select an alternative colour 
using Shape Styles or apply one of the 
picture, gradient or texture effects in Shape 

Fill . 

 If you click on Shape Fill  itself rather 
than the drop arrow, it will apply the colour 
shown on the tool (i.e. the last applied). 

2 
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If you need to select alternative colours for a 
column in a chart, you can select from a wide 
range of pre-set colours from the current theme, 
from a selection of standard colours or even 

specify a custom colour. This allows you to format 
charts to match corporate style guides or other 
colour schemes. Each column in the selected 
series will change colour. 
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CHANGING PIE SLICE COLOUR 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file E833 Chart 
Formatting_4.xlsx... 

 Click on the Sales Pie Chart 
chart sheet tab 

 There are four slices in this 
pie. We can change the colour 
of each of them, or change a 
single slice... 

 Click on the pie to select it 

 You’ll notice pale blue handles 
at the corner of each slice... 

 Click on the blue slice 

 This time, only the blue slice is 
selected and the handles are 
slightly darker in appearance... 

 On the Chart Tools: Format 
tab of the Ribbon, click on the 

drop arrow for Shape Fill  
and click on Aqua, Accent 5 
(top row, second from the end) 

 The slice will change colour 
without affecting the rest of the 
pie 

 

For Your Reference… 

To change the colour of a pie slice: 

1. Click on the pie chart to select it 

2. Click on the individual slice 

3. Click on the drop arrow for Shape Fill  

4. Click on the required colour 

Handy to Know… 

 You can use Shape Fill  to apply a 
range of fancy formatting options to pie slices 
such as textures and gradients. You can 
even insert pictures to create some pretty 
weird effects. 

2 

3 

Pie charts are formatted so that each slice of the 
pie is a different colour. This is because a pie 
represents a single group of figures rather than 
multiple series of figures. You may need to 

change the colour of a pie slice to improve the 
contrast between colours if you print in black and 
white or you may just dislike the standard colours. 

4 
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CHANGING BAR COLOURS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file E833 Chart 
Formatting_5.xlsx... 

 Click on the Costs Bar Chart 
chart sheet tab 

 This is one series and 
therefore it has one colour... 

 Click on any one of the blue 
bars to select the series, then 
click on the Chart Tools: 
Format tab on the Ribbon 

 Click on the dialog box 
launcher  for the Shape 
Styles group, to display the 
Format Data Series dialog 
box 

 Click on the Fill category to 
see the fill options 

 Click on Vary colours by 
point until it appears with a 
tick 

 A range of colours will be 
applied to the bars. Now you 
can colour them individually... 

 Click on [Close] then click on 
the first bar so that it’s the only 
one selected 

 Click on the drop arrow for 

Shape Fill  and select 
Orange, Accent 6 

 

For Your Reference… 

To change bar colours: 

1. Click on the bar 

2. Click on the drop arrow for Shape Fill  
and select a colour 

For Your Reference… 

To vary the colours of a single series: 

1. Click on the series 

2. Click on the dialog box launcher  for 
Shape Styles 

3. Click on Fill then click on Vary colours 

by point and click on [Close] 

5 

7 

Changing the colour of a series of bars is the 
same as changing the colour of a series of 
columns. You select the series then apply a 
different colour. However, how do you change 

the colour of a single bar or column in a chart 
when there is only one series? The first step is to 
change a setting in the Format dialog box to allow 
each bar to be a different colour. 
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CHANGING CHART LINE COLOURS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or 
open the file E833 Chart 
Formatting_6.xlsx... 

 Click on the Sales Trends 
chart sheet tab, then click on 
the red line for Dublin 

 You may find it easier to click 
on one of the markers. The 
markers will appear selected 
and the Chart Elements 
control will display Series 
“Dublin”... 

 On the Chart Tools: Format 
tab of the Ribbon, click on 
the drop arrow for Shape Fill 

 in the Shape Styles 
group, then click on Orange, 
Accent 6 

 The markers will change 
colour but the line will remain 
red – this is most clearly 
seen in the legend... 

 Click on the drop arrow for 

Shape Outline  and click 
on Orange, Accent 6 

 This time the line itself will 
change colour 

 

For Your Reference… 

To change chart line colours: 

1. Click on the line 

2. Click on the drop arrow for Shape Outline 

 and select a colour for the line 

3. Click on the drop arrow for Shape Fill  
and select a colour for the markers 

Handy to Know… 

 Not every line chart will have markers but it’s 
important to know that you can use Shape 

Fill  to change the colour of this part of 
the line. 

1 

2 

Line charts are especially useful for plotting 
values over time and showing trends. The colour 
of lines in a line chart can be changed using 

Shape Outline  while the colour of markers 

in a line chart can be changed using Shape Fill 

. This is a bit tricky, but once you’ve seen how 
it works, it should make sense. 

3 
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USING SHAPE EFFECTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file E833 Chart 
Formatting_7.xlsx... 

 Click on the green line to 
select it 

 On the Chart Tools: Format 
tab of the Ribbon, click on 

Shape Effects  in the 
Shape Styles group, to 
display the list of options 

 Select Shadow, then click on 
the first option on the left under 
Outer 

 The tool tip will read Offset 
Diagonal Bottom Right. A 
shadow will appear below the 
first line... 

 Click on the purple line and 
press  

  repeats the previous 

command and therefore 
applies the same shadow to 
this line... 

 Repeat step 4 for the orange 
and blue lines, then click 
outside the chart to deselect it 

 

For Your Reference… 

To apply a shape effect: 

1. Click on a shape to select it 

2. Click on Shape Effects  

3. Point to the shape effect you want then 
select an option 

Handy to Know… 

 When applying shape effects, the colours 
available under Glow are controlled by the 
theme that is in place. Themes can be 
viewed, changed and modified on the Page 
Layout tab. Themes also affect the colours 

listed under Shape Fill  and Shape 

Outline . 

1 
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Just to make sure that you never run out of 
options or get bored creating charts, Excel 
includes a huge range of shape effects that you 
can apply to objects in your chart. Shape effects 

include presets, shadows, reflections, glow, soft 
edges, bevel and 3-D rotation. You can apply one 
or more effects although some settings override 
others. Try a few and have fun! 

5 
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FILLING THE CHART AREA AND THE PLOT AREA 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file E833 Chart 
Formatting_8.xlsx... 

 Click on the Chart Tools: 
Format tab of the Ribbon, 
then click on a blank, white 
area to the side of the chart 

 You should see the name 
Chart Area displayed in the 
Tool Tip and in the Chart 
Elements control… 

 Click on the drop arrow for 

Shape Fill , then point to 
Texture and select Blue 
tissue paper (1

st
 column, 5

th
 

row) 

 The area behind the plot area 
will be filled... 

 Click in the plot area which is 
the white area behind the lines 

 Blue handles should appear at 
each corner... 

 Click on the drop arrow for 

Shape Fill  and select 
Tan, Background 2 under 
Theme Colours 

 This tones down the white 
area a little to make it more 
compatible with the chart area 
fill 

 

For Your Reference… 

To fill the plot area or chart area: 

1. Click on the plot area or chart area 

2. Click on the drop arrow for Shape Fill  
and select an option 

Handy to Know… 

 If you set the fill for the plot area to No Fill, 
the fill for the chart area will be visible 
throughout the chart. This is the default 
setting for pie charts. 

 When you apply a fill to the plot area, be 
careful not to compromise the readability of 
the chart. 

1 

2 

While you can play with the colours of lines and 
bars on a chart, sometimes all you need to do to 
jazz up a chart is to change the background 
areas. The area behind the lines, columns, bars 

and pie slices is known as the plot area, while the 
area outside (and behind) the plot area is known as 
the chart area. These areas can be modified using 

the Shape Fill  options. 

4 
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FILLING THE BACKGROUND 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file E833 Chart 
Formatting_9.xlsx... 

 Click on the Sales Pie Chart 
chart sheet tab, click on the 
white chart area, then drag 
down and in from the top right-
hand corner to resize it to 
about ⅔ of the original size 

 Move the mouse pointer to the 
top, left of the chart area, then 
drag the chart into the centre 
of the background 

 Click on the Page Layout tab 
of the Ribbon, then click on 

Background  in the Page 
Setup group, to display the 
Sheet Background dialog box 

 Navigate to the Course Files 
for Excel 2010 folder, click on 
E833 Background.jpg and 
click on [Insert] 

 The image will appear behind 
the chart 

 

For Your Reference… 

To fill the background: 

1. Size down the chart and reposition if 
necessary to reveal the background 

2. Click on Background  on the Page 
Layout tab 

3. Locate the image, then click on [Insert] 

Handy to Know… 

 Background graphics are for display only 
and do not print. If you want a picture to print, 
you should add it in the chart area. 

 You can remove a background picture by 

clicking on Delete Background  on the 

Page Layout tab. 

2 
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One area of the chart sheet that is not 
immediately visible is the background. This is 
because the chart initially occupies the entire 
area available on a chart sheet. However, you 

can resize the chart to reveal the background and 
then add a picture to the background to brighten up 
the page for display purposes. 
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THE FORMAT DIALOG BOX 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Each object in a chart can be formatted and 
adjusted in a myriad of ways. These settings are 
so numerous that they would just not fit on a 
ribbon or in a single dialog box, so Excel has 

created many dialog boxes for the purpose and 
each of these is prefixed Format. This page 
examines some examples of the Format dialog box 
and how they are used and accessed. 

Accessing the Format Dialog Box 

The Format dialog box for each object or element on a chart can be displayed by selecting the 

element and then clicking on Format Selection  or on the dialog box launcher for Shape Styles, 
or by right-clicking on the element and selecting Format…. 

Variation in the Format Dialog Box 

Depending upon the element that you have selected when you display the Format dialog box, and 
the type of chart that you are working with, you will see a series of setting categories and various 
controls within these. Some samples are shown below: 

Notice that even the two Format Data 
Series dialog boxes vary, because 
one is for a column chart and the 
other for a pie chart. 
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USING THE FORMAT DIALOG BOX 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file E833 Chart 
Formatting_10.xlsx... 

 On the Sales Pie Chart chart 
sheet, click on the pie to select 
the slices 

 On the Chart Tools: Format 
tab of the Ribbon, click on 

Format Selection  in the 
Current Selection group, to 
display the Format Data 
Series dialog box 

 The controls relate specifically 
to a pie chart... 

 Select the percentage amount 
in Pie Explosion and type 12 

 Click on the Shadow category, 
then click on Presets under 
Shadow and click on 
Perspective Diagonal Lower 
Right (last option) 

 Click on [Close] 

 The changes will be applied to 
the chart 

 

For Your Reference… 

To use the Format dialog box: 

1. Click on the chart element 

2. Click on Format Selection  

3. Make the required changes 

4. Click on [Close] 

Handy to Know… 

 While you have the Format dialog box open, 
you can click on different parts of the chart 
and the Format dialog box will change 
automatically to display the relevant settings. 

1 

5 

The Format dialog box includes a series of 
categories of settings for the chart element that 
you had selected when you displayed the dialog 
box. These categories vary as do the settings in 

each category. However, the controls provide great 
flexibility and allow you to take formatting to a 
whole new level. 
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USING THEMES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file E833 Chart 
Formatting_11.xlsx... 

 Click on the Costs By Month 
chart sheet tab, then click on 
the white edge of the chart to 
select the chart area 

 This is a standard column 
chart with colour and effect 
changes. The chart needs to 
be reset before you can apply 
a theme... 

 Click on the Chart Tools: 
Format tab, then click on 

Reset to Match Style  

 This removes all individual 
modifications such as colour 
changes and shape effects... 

 Click on the Page Layout tab, 

then click on Themes  to 
display the list 

 Click on Apex (or a theme of 
your choice) to apply the 
formatting changes, then click 
outside the chart to deselect it 

 Notice the change to the fonts 
and colours 

 

For Your Reference… 

To apply a theme to a chart: 

1. Select the chart 

2. Click on the Page Layout tab then click on 

Themes  

3. Select the required theme 

Handy to Know… 

 Before you apply a theme to a chart, you 
must remove any existing formats that you 
don’t want retained, by clicking on Reset to 

Match Style . Individual changes to 
shape fill, outlines and effects override 
themes. 

 Themes format the entire workbook. 

1 

2 

If you can’t be bothered fiddling around with the 
fine detail of formatting a chart, or simply don’t 
have time to indulge in fancy formatting, you can 
use a theme to change the appearance of a 

chart. The advantages of using themes are that 
there is a wide range to select from, they format all 
aspects of the chart and they are consistent if you 
need to format charts in separate workbooks. 
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